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ADMINISTRIVIA

Andy OH Changes (see :
→ Thursday March 19 @ 1:00pm
→ Thursday March 26 @ 3:30pm

Homework #4 is due Sunday Mar 22nd @ 11:59pm

Project #3 is due Sunday Apr 5th @ 11:59pm
→ Recitation Wednesday March 18th @ 6:00pm (see @230)

End of Semester Leaderboard Prizes
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LAST CLASS

A DBMS's query optimizer takes logical query plan as 
input and generates a physical execution plan that has 
the lowest "cost".

The quality of the plans that an optimizer generates is 
mostly based on three factors:
→ Transformations / Enumeration
→ Search Algorithm
→ Cost Model
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TODAY'S AGENDA

Search Algorithms

Data Statistics

Cost Models

DB Flash Talk: Firebolt
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SEARCH ALGORITHM

Approach #1: Bottom-Up / Forward Chaining
→ Start with nothing and then iteratively assemble and add 

building blocks to generate a query plan. 
→ Examples: System R, Starburst

Approach #2: Top-Down / Backward Chaining
→ Start with the outcome that the query wants and then 

transform it to equivalent alternative sub-plans to find the 
optimal plan that gets to that goal.

→ Examples: Volcano, Cascades
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BOTTOM-UP OPTIMIZATION

Use static rules to perform initial optimization.
Then use dynamic programming to determine
the best join order for tables using a divide-and-
conquer search method

Examples: IBM System R, DB2, MySQL, Germans, 
DuckDB, Postgres, most open-source DBMSs.
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IBM SYSTEM R: OPTIMIZER

IBM SYSTEM R: OPTIMIZER

Break query into blocks and generate 
logical operators for each block.

For each logical operator, generate a 
set of physical operators that 
implement it.
→ All combinations of join algorithms and 

access paths

If a block accesses multiple relations, 
iteratively construct a join tree that 
minimizes the estimated amount of 
work to execute the plan.
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IBM SYSTEM R: OPTIMIZER

IBM SYSTEM R: OPTIMIZER
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Step #1: Choose the best access paths 
to each table 

ARTIST: Sequential Scan

APPEARS: Sequential Scan

ALBUM: Index Look-up on NAME

SELECT ARTIST.NAME
  FROM ARTIST, APPEARS, ALBUM
 WHERE ARTIST.ID=APPEARS.ARTIST_ID 
   AND APPEARS.ALBUM_ID=ALBUM.ID
   AND ALBUM.NAME=“Andy's OG Remix”
 ORDER BY ARTIST.ID

https://db.cs.cmu.edu/
https://15445.courses.cs.cmu.edu/spring2026


CMU DATABASE SYSTEMS (SPRING 2026)

CMU DATABASE SYSTEMS (SPRING 2026)

IBM SYSTEM R: OPTIMIZER

IBM SYSTEM R: OPTIMIZER

8

Step #1: Choose the best access paths 
to each table 

ARTIST: Sequential Scan

APPEARS: Sequential Scan

ALBUM: Index Look-up on NAME

ARTIST  ⨝ APPEARS ⨝ ALBUM
APPEARS ⨝ ALBUM   ⨝ ARTIST
ALBUM   ⨝ APPEARS ⨝ ARTIST
APPEARS ⨝ ARTIST  ⨝ ALBUM
ARTIST  ×  ALBUM   ⨝ APPEARS
ALBUM   × ARTIST  ⨝ APPEARS
⋮           ⋮          ⋮

Step #2: Enumerate all possible join 
orderings for tables

SELECT ARTIST.NAME
  FROM ARTIST, APPEARS, ALBUM
 WHERE ARTIST.ID=APPEARS.ARTIST_ID 
   AND APPEARS.ALBUM_ID=ALBUM.ID
   AND ALBUM.NAME=“Andy's OG Remix”
 ORDER BY ARTIST.ID
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IBM SYSTEM R: OPTIMIZER

IBM SYSTEM R: OPTIMIZER
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Step #1: Choose the best access paths 
to each table 

Step #3: Determine the join ordering 
with the lowest cost

ARTIST: Sequential Scan

APPEARS: Sequential Scan

ALBUM: Index Look-up on NAME

ARTIST  ⨝ APPEARS ⨝ ALBUM
APPEARS ⨝ ALBUM   ⨝ ARTIST
ALBUM   ⨝ APPEARS ⨝ ARTIST
APPEARS ⨝ ARTIST  ⨝ ALBUM
ARTIST  ×  ALBUM   ⨝ APPEARS
ALBUM   × ARTIST  ⨝ APPEARS
⋮           ⋮          ⋮

Step #2: Enumerate all possible join 
orderings for tables

SELECT ARTIST.NAME
  FROM ARTIST, APPEARS, ALBUM
 WHERE ARTIST.ID=APPEARS.ARTIST_ID 
   AND APPEARS.ALBUM_ID=ALBUM.ID
   AND ALBUM.NAME=“Andy's OG Remix”
 ORDER BY ARTIST.ID
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ARTIST ALBUM APPEARS

ARTIST ⨝ APPEARS ⨝ ALBUM

Logical Op

Physical Op

https://db.cs.cmu.edu/
https://15445.courses.cs.cmu.edu/spring2026
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ARTIST ALBUM APPEARS

ARTIST⨝APPEARS
ALBUM

ALBUM⨝APPEARS
ARTIST

APPEARS⨝ALBUM
ARTIST • • •

HASH_JOIN(A1,A3) MERGE_JOIN(A1,A3) HASH_JOIN(A2,A3) MERGE_JOIN(A2,A3) HASH_JOIN(A3,A2) MERGE_JOIN(A3,A2) • • •

ARTIST ⨝ APPEARS ⨝ ALBUM

ARTIST.ID=APPEARS.ARTIST_ID

ALBUM.ID=APPEARS.ALBUM_ID 

APPEARS.ALBUM_ID=ALBUM.ID

Logical Op

Physical Op

https://db.cs.cmu.edu/
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ARTIST ALBUM APPEARS

ARTIST⨝APPEARS
ALBUM

ALBUM⨝APPEARS
ARTIST

APPEARS⨝ALBUM
ARTIST • • •

HASH_JOIN(A1,A3) HASH_JOIN(A2,A3) MERGE_JOIN(A3,A2) • • •

HASH_JOIN(A1⨝A3,A2) MERGE_JOIN(A1⨝A3,A2) HASH_JOIN(A2⨝A3,A1) MERGE_JOIN(A2⨝A3,A1) HASH_JOIN(A3⨝A2,A1) • • •MERGE_JOIN(A3⨝A2,A1)
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ARTIST ALBUM APPEARS

ARTIST⨝APPEARS
ALBUM

ALBUM⨝APPEARS
ARTIST

APPEARS⨝ALBUM
ARTIST • • •

HASH_JOIN(A1,A3) HASH_JOIN(A2,A3) MERGE_JOIN(A3,A2) • • •

HASH_JOIN(A1⨝A3,A2) HASH_JOIN(A2⨝A3,A1) HASH_JOIN(A3⨝A2,A1) • • •

ARTIST ⨝ APPEARS ⨝ ALBUM

ARTIST.ID=APPEARS.ARTIST_ID

ALBUM.ID=APPEARS.ALBUM_ID 

APPEARS.ALBUM_ID=ALBUM.ID

APPEARS.ALBUM_ID=ALBUM.ID APPEARS.ARTIST_ID=ARTIST.IDAPPEARS.ARTIST_ID=ARTIST.ID

Logical Op
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ARTIST ALBUM APPEARS

ALBUM⨝APPEARS
ARTIST

HASH_JOIN(A2,A3)

HASH_JOIN(A2⨝A3,A1)

ARTIST ⨝ APPEARS ⨝ ALBUM

ALBUM.ID=APPEARS.ALBUM_ID 

APPEARS.ARTIST_ID=ARTIST.ID

Logical Op

Physical Op
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ARTIST ALBUM APPEARS

ALBUM⨝APPEARS
ARTIST

HASH_JOIN(A2,A3)

HASH_JOIN(A2⨝A3,A1)

ARTIST ⨝ APPEARS ⨝ ALBUM

ALBUM.ID=APPEARS.ALBUM_ID 

APPEARS.ARTIST_ID=ARTIST.ID

Logical Op

Physical Op

Keep track of best plans with and 
without data in proper physical form, 
and then check whether tacking on a sort 
operator at the end is better.

The query has ORDER BY on 
ARTIST.ID but the logical plans 
do not contain sorting properties.`
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TOP-DOWN OPTIMIZATION

TOP-DOWN OPTIMIZATION

MSSQL Greenplum CockroachDB Calcite

Start with a logical plan of what we want the query to 
be. Perform a branch-and-bound search to traverse the 
plan tree by converting logical operators into physical 
operators.
→ Keep track of global best plan during search.
→ Treat physical properties of data as first-class entities during 

planning.

Examples: MSSQL, Greenplum, CockroachDB, Calcite
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MSSQL Greenplum CockroachDB Calcite
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be. Perform a branch-and-bound search to traverse the 
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planning.

Examples: MSSQL, Greenplum, CockroachDB, Calcite

10

5

https://db.cs.cmu.edu/
https://15445.courses.cs.cmu.edu/spring2026
https://www.youtube.com/watch?v=pQe1LQJiXN0&list=PLSE8ODhjZXjYPyrUG_YxqYPS7wjWY6gYN&index=1
https://www.youtube.com/watch?v=8NzvZ9X8inM&list=PLSE8ODhjZXjYPyrUG_YxqYPS7wjWY6gYN&index=10
https://www.youtube.com/watch?v=wHo-VtzTHx0&list=PLSE8ODhjZXjYPyrUG_YxqYPS7wjWY6gYN&index=4&t=917s
https://calcite.apache.org/
https://www.microsoft.com/en-us/research/publication/extensible-query-optimizers-in-practice/


CMU DATABASE SYSTEMS (SPRING 2026)

CMU DATABASE SYSTEMS (SPRING 2026)

TOP-DOWN OPTIMIZATION

TOP-DOWN OPTIMIZATION

11

ARTIST ⨝ APPEARS ⨝ ALBUM
ORDER-BY(ARTIST.ID)

Invoke rules to create new nodes 
and traverse tree.
→ Logical→Logical:

JOIN(A,B) to JOIN(B,A)
→ Logical→Physical: 

JOIN(A,B) to HASH_JOIN(A,B)

Start with a logical plan of what 
we want the query to be.

Logical Op

Physical Op

https://db.cs.cmu.edu/
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→ Logical→Logical:

JOIN(A,B) to JOIN(B,A)
→ Logical→Physical: 

JOIN(A,B) to HASH_JOIN(A,B)

Can create "enforcer" rules
that require input to have 
certain properties.

ARTIST ALBUM APPEARS

HASH_JOIN(A1⨝A2,A3)

SORT(A1.ID)

MERGE_JOIN(A1⨝A2,A3)

HASH_JOIN(A1,A2)

ALBUM⨝APPEARS ARTIST⨝ALBUMARTIST⨝APPEARS

HASH_JOIN(A1⨝A2,A3)

MERGE_JOIN(A1,A2)

Start with a logical plan of what 
we want the query to be.

Logical Op

Physical Op
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OBSERVATION

OBSERVATION

We have formulas for the operator 
algorithms (e.g., the cost formulas for 
hash join, sort-merge join), but we 
also need to estimate the size of the 
output that an operator produces.

                                    
                                    

13

Dept

Emp

πename

⋈Emp.did = Dept.did

σename,did
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OBSERVATION

OBSERVATION

We have formulas for the operator 
algorithms (e.g., the cost formulas for 
hash join, sort-merge join), but we 
also need to estimate the size of the 
output that an operator produces.

This is hard because the output of 
each operators depends on its input.
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Dept

Emp

πename

⋈Emp.did = Dept.did

σename,did
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???
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COST ESTIMATION

The DBMS uses a cost model to predict the behavior of 
a query plan given a database state.
→ This is an internal cost that allows the DBMS to compare one 

plan with another.

It is too expensive to run every possible plan to 
determine this information, so the DBMS need a way to 
derive this information.

14
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COST MODEL COMPONENTS

Choice #1: Physical Costs
→ Predict CPU cycles, I/O, cache misses, RAM consumption,  

network messages…
→ Depends heavily on hardware.

Choice #2: Logical Costs
→ Estimate output size per operator.
→ Independent of the operator algorithm.
→ Need estimations for operator result sizes.

15
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POSTGRES COST MODEL

POSTGRES COST MODEL

Uses a combination of CPU and I/O costs that are 
weighted by “magic” constant factors.

Default settings are obviously for a disk-resident 
database without a lot of memory:
→ Processing a tuple in memory is 400x faster than reading a 

tuple from disk.
→ Sequential I/O is 4x faster than random I/O.

16
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STATISTICAL SUMMARIES

Auxiliary data structures that the DBMS populates from 
scanning the database to allow the optimizer to 
approximate data contents for different scenarios.

Trade-offs to consider:
→ Accuracy
→ Efficiency
→ Memory Consumption
→ Coverage / Applicability
→ Creation + Maintenance Costs

17

Source: EQOP Book
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STATISTICS STORAGE

Most DBMSs store a database's statistics in its internal 
catalog.

The DBMS will periodically update statistics according 
to one or more triggering mechanisms:
→ Periodic Background Tasks (e.g., Postgres Autovacuum)
→ Maintenance Schedules (e.g., Oracle)
→ Modification Thresholds
→ Manual Invocation (e.g., ANALYZE, UPDATE STATISTICS)

18
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COLUMN STATISTICS

Most DBMSs create single-column statistics for each 
column in a table.

The DBMS can also track statistics for groups of 
attributes together rather than just treating them all as 
independent variables.
→ Some systems automatically build multi-column statistics if 

they are already used in an index together (MSSQL).
→ Otherwise, a human manually specifies target columns.
→ Also called Column Group Statistics (Db2) or Extended 

Statistics (Oracle).

19

https://db.cs.cmu.edu/
https://15445.courses.cs.cmu.edu/spring2026
https://learn.microsoft.com/en-us/sql/relational-databases/statistics/statistics?view=sql-server-ver16#query-predicate-contains-multiple-correlated-columns
https://www.ibm.com/docs/en/db2/11.5?topic=plans-column-group-statistics
https://blogs.oracle.com/optimizer/post/extended-statistics
https://blogs.oracle.com/optimizer/post/extended-statistics


CMU DATABASE SYSTEMS (SPRING 2026)

CMU DATABASE SYSTEMS (SPRING 2026)

SUMMARIZATION APPROACHES

SUMMARIZATION APPROACHES

Choice #1: Histograms
→ Maintain an occurrence count per value (or range of values) in 

a column.

Choice #2: Sketches
→ Probabilistic data structure that gives an approximate count for 

a given value.

Choice #3: Sampling
→ DBMS maintains a small subset of each table that it then uses to 

evaluate expressions to compute selectivity.

Choice #4: ML Model
→ Train an ML model that learns the selectivity of predicates and 

correlations between multiple tables.

20

Most Common

Rare

Increasing Usage

Experimental / Very Rare

https://db.cs.cmu.edu/
https://15445.courses.cs.cmu.edu/spring2026


CMU DATABASE SYSTEMS (SPRING 2026)

CMU DATABASE SYSTEMS (SPRING 2026)

0

5

10

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Histogram

HISTOGRAMS

HISTOGRAMS

Approximate the distribution of values in a column for 
cardinality estimation.
→ Maintain an occurrence count per value (or range of values) in 

a column.

21
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# of occurrences

Distinct values of attribute
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HISTOGRAMS

Approximate the distribution of values in a column for 
cardinality estimation.
→ Maintain an occurrence count per value (or range of values) in 

a column.
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# of occurrences

15 keys × 32-bits =

60 bytes
Distinct values of attribute
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EQUI-WIDTH HISTOGRAM

EQUI-WIDTH HISTOGRAM

Maintain counts for a group of values instead of each 
unique key. All buckets have the same width (i.e., same 
# of value).

22
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EQUI-WIDTH HISTOGRAM

Maintain counts for a group of values instead of each 
unique key. All buckets have the same width (i.e., same 
# of value).
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EQUI-DEPTH HISTOGRAMS

EQUI-DEPTH HISTOGRAMS

Vary the width of buckets so that the total number of 
occurrences for each bucket is roughly the same.
→ Equi-depth histograms are shown to have better worst-case and 

average error than equi-width histograms.

23
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END-BIASED HISTOGRAMS

END-BIASED HISTOGRAMS

Use N-1 buckets to store the exact count for the most 
frequent keys. The last bucket (R) stores the average 
frequency of all remaining values.

24
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Use N-1 buckets to store the exact count for the most 
frequent keys. The last bucket (R) stores the average 
frequency of all remaining values.
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Use N-1 buckets to store the exact count for the most 
frequent keys. The last bucket (R) stores the average 
frequency of all remaining values.
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SKETCHES

Maintaining exact statistics about the database is 
expensive and slow.

Use probabilistic data structures called sketches to 
generate error-bounded estimates.
→ Frequent Items (Count-min Sketch)
→ Count Distinct (HyperLogLog)
→ Quantiles (t-digest)

Open-source implementations are available (Apache 
DataSketches, Google ZetaSketch)

25
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COUNT-MIN SKETCH

COUNT-MIN SKETCH

Probabilistic data structure that 
approximates frequency counts of 
elements in a data stream using hash 
functions and a multi-dimensional 
array of counters.

Approximates answers with tunable 
accuracy and space trade-offs.

26
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HYPERLOGLOG

HYPERLOGLOG

Harmonic mean

Probabilistic data structure to 
approximate cardinality of a multiset.
→ Store m fixed-size array of counters.

Update:
→ The first b bits of the hash determine 

which counter to update.
→ Calculate the position of the leftmost 1-bit 

in remaining bits.

Estimate:
→ Compute the Harmonic mean across 

counters and correct with a corrective 
fudge factor.
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SAMPLING

Execute a predicate on a random sample of the target 
data set. The number of tuples to examine depends on 
the size of the original table.

Approach #1: Maintain Read-Only Copy
→ Periodically refresh to maintain accuracy.

Approach #2: Sample Real Tables
→ May read multiple versions of same logical tuple.

28
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SAMPLING

SAMPLING

Modern DBMSs also collect samples 
from tables to estimate selectivities.

Update samples when the number of 
changes to underlying tables exceeds 
some threshold.

29

⋮
1 billion tuples

SELECT AVG(age)
  FROM people 
 WHERE age > 50

id name age status

1001 Obama 64 Rested

1002 Swift 36 Engaged

1003 Tupac 25 Dead

1004 Mr.Beast 27 Creepy

1005 DJ Cache 23 Paid

1006 TigerKing 63 Jailed
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CARDINALITY ESTIMATION

Estimate the number of rows that a query operator will 
produce, such as a filter or join, to help the optimizer 
choose the most efficient execution plan.

There are three cardinality estimations an optimizer 
must support as the core of its cost model:
→ Selection Conditions (filters)
→ Join Size Estimation
→ Distinct Value Estimation

30

Source: EQOP Book
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DERIVABLE STATISTICS

For each relation R, the DBMS maintains statistics to 
approximate the following information:
→ NR: Number of tuples in R.
→ V(A,R): Number of distinct values for attribute A.

The selection cardinality SC(A,R) is the average 
number of tuples with a value for an attribute A given 
NR  /   V(A,R)

31
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SINGLE SELECTION CONDITION

SINGLE SELECTION CONDITION

The selectivity (sel) of a predicate P 
is the fraction of tuples that qualify.

Equality Predicate: A=constant
→ sel(A=constant) = #occurrences /  | R |
→ Example: sel(age=9)

32

0

5

10

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Histogram

SELECT * FROM people 
 WHERE age = 9
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SELECT * FROM people 
 WHERE age = 9
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SINGLE SELECTION CONDITION

The selectivity (sel) of a predicate P 
is the fraction of tuples that qualify.

Equality Predicate: A=constant
→ sel(A=constant) = #occurrences /  | R |
→ Example: sel(age=9)

32

SELECT * FROM people 
 WHERE age = 9

= 4 /45 = 0.088
≈ (9/5) /45 ≈  1.8 /45 ≈ 0.04
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ASSUMPTIONS

Assumption #1: Uniform Data
→ The distribution of values (except for the heavy hitters) is the 

same within a histogram bucket.

33

https://db.cs.cmu.edu/
https://15445.courses.cs.cmu.edu/spring2026


CMU DATABASE SYSTEMS (SPRING 2026)

CMU DATABASE SYSTEMS (SPRING 2026)

12 12

9

12

0

5

10

15

[1,5] [6,8] [9,13] [14,15]

Equi-Depth Histogram

SINGLE SELECTION CONDITION

SINGLE SELECTION CONDITION

Range Predicate:
→ sel(A >= a) = (#RANGE-ROWS + #EQ-

ROWS) / | R |
→ Example: sel(age >= 7) 

34

SELECT * FROM people 
 WHERE age >= 7
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SINGLE SELECTION CONDITION

Range Predicate:
→ sel(A >= a) = (#RANGE-ROWS + #EQ-

ROWS) / | R |
→ Example: sel(age >= 7) 

34

≈ ((9+12)

SELECT * FROM people 
 WHERE age >= 7
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SINGLE SELECTION CONDITION

Range Predicate:
→ sel(A >= a) = (#RANGE-ROWS + #EQ-

ROWS) / | R |
→ Example: sel(age >= 7) 

34

≈ ((9+12)

SELECT * FROM people 
 WHERE age >= 7

+ (2 × (12/3))) / 45
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SINGLE SELECTION CONDITION

Range Predicate:
→ sel(A >= a) = (#RANGE-ROWS + #EQ-

ROWS) / | R |
→ Example: sel(age >= 7) 

34

≈ ((9+12)

SELECT * FROM people 
 WHERE age >= 7

+ (2 × (12/3))) / 45
≈ 29 / 45 ≈  0.6444
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SINGLE SELECTION CONDITION

SINGLE SELECTION CONDITION

Range Predicate:
→ sel(A >= a) = (#RANGE-ROWS + #EQ-

ROWS) / | R |
→ Example: sel(age >= 7) 

34

≈ ((9+12)

SELECT * FROM people 
 WHERE age >= 7

+ (2 × (12/3))) / 45
≈ 29 / 45 ≈  0.6444

This assumes continuous distribution of values.
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SINGLE SELECTION CONDITION

SINGLE SELECTION CONDITION

Negation Query:
→ sel(not P) = 1 – sel(P)
→ Example: sel(age != 2)

35

SELECT * FROM people 
 WHERE age != 2
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https://15445.courses.cs.cmu.edu/spring2026


CMU DATABASE SYSTEMS (SPRING 2026)

CMU DATABASE SYSTEMS (SPRING 2026)

12 12

9

12

0

5

10

15

1-5 6-8 9-13 14-15

Equi-Depth Histogram

SINGLE SELECTION CONDITION

SINGLE SELECTION CONDITION

Negation Query:
→ sel(not P) = 1 – sel(P)
→ Example: sel(age != 2)

35

SELECT * FROM people 
 WHERE age != 2

https://db.cs.cmu.edu/
https://15445.courses.cs.cmu.edu/spring2026


CMU DATABASE SYSTEMS (SPRING 2026)

CMU DATABASE SYSTEMS (SPRING 2026)

12 12

9

12

0

5

10

15

1-5 6-8 9-13 14-15

Equi-Depth Histogram

SINGLE SELECTION CONDITION

SINGLE SELECTION CONDITION

Negation Query:
→ sel(not P) = 1 – sel(P)
→ Example: sel(age != 2)

35

SELECT * FROM people 
 WHERE age != 2

https://db.cs.cmu.edu/
https://15445.courses.cs.cmu.edu/spring2026


CMU DATABASE SYSTEMS (SPRING 2026)

CMU DATABASE SYSTEMS (SPRING 2026)

12 12

9

12

0

5

10

15

1-5 6-8 9-13 14-15

Equi-Depth Histogram
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SINGLE SELECTION CONDITION

Negation Query:
→ sel(not P) = 1 – sel(P)
→ Example: sel(age != 2)

35

SELECT * FROM people 
 WHERE age != 2

≈  1 - ((12/5) /45)
≈  1 - (2.4 /45) ≈  1 - 0.05 ≈ 0.95

Observation: Selectivity ≈  Probability
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OBSERVATION

OBSERVATION

We can compute selectivities for 
individual predicates, but what 
happens if there are multiple 
predicates in a query?
→ Even though the predicates are on the 

same table, the attributes may have 
different distributions.

Example: 
→ sel(age = 2) ≈ 0.053
→ sel(name LIKE 'A%') ≈ 0.1

36

SELECT * FROM people 
 WHERE age = 2
   AND name LIKE 'A%'
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ASSUMPTIONS

Assumption #1: Uniform Data
→ The distribution of values (except for the heavy hitters) is the 

same within a histogram bucket.

Assumption #2: Independent Predicates
→ The selectivity of the conjunction of two or more predicates is 

estimated as the product of their individual selectivities.

37
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MULTIPLE SELECTION CONDITION

MULTIPLE SELECTION CONDITION

Conjunction: 
→ sel(P1 ⋀ P2) = sel(P1) × sel(P2)
→ Example: sel(age=2 ⋀ name LIKE 'A%')

This assumes that the predicates are 
independent.
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SELECT * FROM people 
 WHERE age = 2
   AND name LIKE 'A%'

≈ sel(age=2) × sel(name LIKE 'A%') 
≈ 0.053 × 0.1 ≈ 0.0053

P1 P2
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MULTIPLE SELECTION CONDITION

MULTIPLE SELECTION CONDITION

Conjunction: 
→ sel(P1 ⋀ P2) = sel(P1) × sel(P2)
→ Example: sel(age=2 ⋀ name LIKE 'A%')

This assumes that the predicates are 
independent.

Optimization: When there are 
multiple predicates, diminish their 
weights to reduce underestimations.
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SELECT * FROM people 
 WHERE age = 2
   AND name LIKE 'A%'

≈ sel(age=2) × sel(name LIKE 'A%') 
≈ 0.053 × 0.1 ≈ 0.0053

P1 P2
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MULTIPLE SELECTION CONDITION

MULTIPLE SELECTION CONDITION

Disjunction: 
→ sel(P1 ⋁ P2)

 ≈ sel(P1) + sel(P2) – sel(P1 ⋀ P2)
 ≈ sel(P1) + sel(P2) – sel(P1) × sel(P2)

          

                            
                  

39

SELECT * FROM people 
 WHERE age = 2
    OR name LIKE 'A%'

P1 P2
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Disjunction: 
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 ≈ sel(P1) + sel(P2) – sel(P1) × sel(P2)
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MULTIPLE SELECTION CONDITION

MULTIPLE SELECTION CONDITION

Disjunction: 
→ sel(P1 ⋁ P2)

 ≈ sel(P1) + sel(P2) – sel(P1 ⋀ P2)
 ≈ sel(P1) + sel(P2) – sel(P1) × sel(P2)

→ Example: sel(age=2 ⋁ name LIKE 'A%')

This again assumes that the
selectivities are independent.
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SELECT * FROM people 
 WHERE age = 2
    OR name LIKE 'A%'

≈ 0.053 + 0.1 – (0.053 × 0.1)
≈ 0.1477 P1 P2
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CORRELATED ATTRIBUTES

CORRELATED ATTRIBUTES

Consider a database of automobiles:
→ # of Makes = 10, # of Models = 100

Then the following query shows up:
→  WHERE (make='Honda' AND model='Accord')

With the independence and uniformity assumptions,  
the selectivity is:
→ 1/10 × 1/100 ≈  0.001

But since only Honda makes Accords the real selectivity 
is 1/100 = 0.01

40

Guy Lohman

Source: Guy Lohman
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JOIN SIZE ESTIMATION

Given a join of R and S, what is the range of possible 
result sizes in # of tuples?
→ In other words, for a given tuple of R,  how many tuples of S 

will it match?

Assume each key in the inner relation will exist in the 
outer table.

41
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ASSUMPTIONS

Assumption #1: Uniform Data
→ The distribution of values (except for the heavy hitters) is the 

same within a histogram bucket.

Assumption #2: Independent Predicates
→ The selectivity of the conjunction of two or more predicates is 

estimated as the product of their individual selectivities.

Assumption #3: Containment Principle
→ The domain of join keys overlap such that each key in the inner 

relation will also exist in the outer table.

42
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JOIN SIZE ESTIMATION

General case: Rcols⋂ Scols={A} where A is not a primary 
key for either table.
→ Match each R-tuple with S-tuples:

estSize ≈ NR × NS / V(A,S)
→ Symmetrically, for S:

estSize ≈ NR × NS / V(A,R)

The cardinality estimate of a join is: 
→ estSize ≈ NR × NS / max({V(A,S), V(A,R)})

43
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ERROR PROPAGATION

ERROR PROPAGATION

44

SELECT A.id
  FROM A, B, C
 WHERE A.id = B.id
   AND A.id = C.id
   AND B.id > 100

A

⨝A.id=B.id

B
B.id>100

C

A.id=C.id

A.id

⨝
π

Compute the cardinality of base tables
A → |A|
B.id > 100 → |B| × sel(B.id > 100)
C → |C|
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44

SELECT A.id
  FROM A, B, C
 WHERE A.id = B.id
   AND A.id = C.id
   AND B.id > 100

A

⨝A.id=B.id

B
B.id>100

C

A.id=C.id

A.id

⨝
π

Compute the cardinality of base tables

Compute the cardinality of join results

A → |A|
B.id > 100 → |B| × sel(B.id > 100)
C → |C|

A⨝B ≈  (|A| × |B|) /
max(sel(A.id=B.id), sel(B.id>100))
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⨝
π

Compute the cardinality of base tables

Compute the cardinality of join results

A → |A|
B.id > 100 → |B| × sel(B.id > 100)
C → |C|

A⨝B ≈  (|A| × |B|) /
max(sel(A.id=B.id), sel(B.id>100))

(A⨝B)⨝C ≈  (|A| × |B| × |C|) /
max(sel(A.id=B.id), sel(B.id>100),

sel(A.id=C.id))
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ESTIMATOR QUALITY

ESTIMATOR QUALITY
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Viktor Leis

Source: Viktor Leis
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CONCLUSION

CONCLUSION

Statistics allow the optimizer to summarize the contents 
of the database.
→ These data structures are only approximations of real data.

Then the optimizer guesses how many tuples it will 
examine or emit at each operator in a query plan.
→ Another approximation of what a real predicate will do.

This entire process is fraught with errors.

46

https://db.cs.cmu.edu/
https://15445.courses.cs.cmu.edu/spring2026


CMU DATABASE SYSTEMS (SPRING 2026)

CMU DATABASE SYSTEMS (SPRING 2026)

CONCLUSION

CONCLUSION

Statistics allow the optimizer to summarize the contents 
of the database.
→ These data structures are only approximations of real data.

Then the optimizer guesses how many tuples it will 
examine or emit at each operator in a query plan.
→ Another approximation of what a real predicate will do.

This entire process is fraught with errors.

46
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NEXT CLASS

Transactions!
→ aka the second hardest part about database systems

47
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